
Potential Issues on Installing/Running LabelTrace 
 

Printer Related Issues (EPL unless otherwise stated) 
 
1. Printer does not respond to label formats being sent - possible causes:- 
 

a. Check the power is on (users may be unaware of switch on side of printer) and lid 
closed so illuminated green round feed key. 

b. Check that the labels have not run out. 
 

Perform autocalibration (Power on with feed key pressed, release feed key as soon as 
starts to flash. Ensure press feed key a couple of times at end of procedure to get 
back to normal printing mode but see Issue 5). If printer does not respond to label 
formats being sent, although prints diagnostic data etc OK. - possible causes:- 

c. Check the comms cable is properly connected (and not faulty or intended for a 
different printer!). 

d. The default comms configuration may not be set to the required values 96,N,8,1. 
Sometimes it is set to 38Kbaud out of the box. Need to use a software command to set 
to normal default. Create a text file containing a single line “Y96,N,8,1” followed by a 
newline, save with name eg setbaud.txt. Use a suitable communications package 
(configured to match the current comms parameters of the printer) to send this file to 
the printer. The printer will now be set to the required comms parameters. 

e. Check that the port setting for the printer is still correct. It may have been removed 
and then reconnected but to the wrong port on the PC. 

 
2. Printer appears to be jammed as it makes a buzzing sound and does not feed labels 

properly. 
 

a. check that the disks which support the label core are not set for larger cores, ie the 
lower half of the disk is raised not lowered. 

b. ensure that the label roll core is on the disks ie that the roll is not simply lying in the 
bottom of the printer. 

c. Try removing a little of the inner face of the cardboard core - this will reduce friction 
in the case of a distorted core. 

 
3. The printer prints what users describe as “gobbledegook” – actually the data sent to the 

printer is printed exactly as sent, rather than causing a label to be printed. Two possible 
causes:- 

 
a. Could be due to printer having been configured to line mode instead of page mode 

by finger trouble. Check this by doing an autocalibrate and checking the mode as 
reported on labels at end of this procedure but see Issue 5. Change to page mode 
as described in manual supplement in box or by printing the “set page mode” 
template on the web site page 
http://www.quicktrace.co.uk/support/samples/printercontrol/index.php 

b. The printer may have been left in dump mode after an autocalibrate procedure – 
press the feed key a couple of times to ensure back in normal printing mode. 

 
4. The printer appears to respond correctly to a request for labels but the labels are blank. 
 



If other printers such as the TLP2742 are in use elsewhere within the practice it is likely 
that the labels for that printer (which are printed with a ribbon) have been installed by 
mistake. Replace the labels with the correct DIRECT THERMAL type. 

5. When initiate autosense calibration, printer immediately prints configuration information 
without slowly feeding a few blank labels first. This indicates that the autosense 
calibration has not correctly operated. Solution is to change to Line mode as described 
in manual supplement in box or by printing the “line mode” template on the Printer tab. 
Now perform the autosense calibration and finally change back to Page Mode. 

 
6.  The printer appears to print but the image is very faint, even at max print density. Ensure 

that the correct power supply is connected. If the wrong power supply is connected, the 
printer light may illuminate but insufficient current can be provided to print correctly!! [if 
in demo mode it may be using “01” as print density as “10” will be converted to “01” on 
printing in demo mode.] 

 
7.  A field printed in a font rotated by 90 or 270 degrees does not appear. There is too 

much data for the available image area. In fonts in normal (0 degrees) or inverted (180 
degrees) orientations, the data will “wrap” and be printed at the L/R edge but it does not 
print at all in 90 or 270 degree orientations. 

 
8.  The printer will not print and the red light is on round the feed key. Pressing down on the 

lid causes the light to go green and the printer will print but reverts to red on ceasing to 
press down on the lid. Most likely cause is the the head open sensor has drifted out of 
tolerance.  Solution… 

 
1. With the hood down and latched, press down on the corner of the hood 
nearest the status indicator/feed switch until the status indicator turns 
green, and hold it firmly through steps 2 and 3. 
2. Turn the power switch off. 
3. Once the status indicator turns off, turn the power switch back on. 
Verify that the status indicator is green; if not, repeat steps 1 through 3. 
4. Release the hood, unlatch it, and raise it fully. 
5. Lower the hood, latch it, and press down on it until the status indicator 
turns green. 
6. Release the hood. The status indicator will remain green, and the Hood-Up 
Sensor will now be calibrated. 

 
9.  The label image seems only to print on one side of the label. Check that the lid is fully 

closed and latched on both sides by pressing down firmly on both sides. 
 
10. On clicking to print from LabelTrace an error message results 

“error initializing printer – the label trace print manager may be running”. 
This will happen if the printer is connected by serial cable with LabelTrace set to print 
directly to a COM port with hardware handshaking selected and ...  
1 The printer is switched off.  
2. The comms cable is not connected. 
3. Another program has already got control of the port e.g. Hotsync for Palm devices, 
Activesync for other handheld devices, modem control applications or a printer driver. 
 
If you cannot determine which application is hogging the port - Use the SysInternals 
"Process Explorer" to investigate. In Process Explorer, select "Find Handle or DLL" and 



search for the word "serial". This should show anything that is using your serial ports. 
Even if the process doesn't have a name, it will have a Process ID number (PID). You can 
go into the Windows Task Manager (via Ctrl-Alt-Del) and select View -> Select Columns 
to enable viewing the Process ID numbers, which can lead you to the image name of the 
program that's using your serial port. 
 
As a final effort, go to Device Manager and delete the port, then reinstall it. 

 

11. Installing Brother printers with B-pacs software - You may receive a "1607:Unable to 
install InstallShield Scripting runtime" error message when you try to install the B-pacs 
software in Windows XP. Some possible causes are listed here 
http://support.microsoft.com/kb/888019 

 

12. Attempting to print to Seiko Smart Label Printer  - get “divide by zero” error. This can 
be caused by the graphics for the PC being set to use 16 bit colour. Ensure that 32 bit 
colour is selected. 

 

13. The LP2824 Plus can appear to fail to print a label. This will occur if there is no data for 
the label. The LP2824 in these circumstances does print a blank label. 

 

14. Printing appears to be working correctly but no label is printed -  can occur because 
LabelTrace is printing directly to the printer but the “Use FlexaTrace” check box in 
Printer Preferences has been set. 

 
 
 
 



Software Issues GPASS (SQL6.5 / SQL2000) Version 
 
1. (Versions before V2.3.0.588) Where there is a branch surgery with different address, may 

need to make a copy of the “LTDATA” folder and give the copy a different name. This 
copy may then be utilised by the workstations in the branch allowing the address data to 
be specific to the branch. 

 
Variations on this approach may be required to meet specific circumstances. 

2. If have several practices sharing server, may need to proceed as in 4 but in addition, the 
external doctors list will have to contain a merged list of doctors from each practice. 

 
3. When installing LT_Central may get errors on database creation 
 

“Invalid object name ‘sysdatabases’ 
followed by (1 row affected) 3 times 
creating QTRACE device 
followed by (1 row affected) 5 times 
creating QTRACELOG device 
followed by (1 row affected) 6 times. 

 
MH says not a problem - database correctly created. To do with different database being 
set as default, as compared to typical situation. 

4. During install of Management Utility or Client, may get messages re locked files, asking 
if want to overwrite - say Yes. 

 
5. If get message on starting Encounter that dd/mm/yy is not a valid date, this may be 

because the Regional settings need to be changed to English (United Kingdom). 
 
6. If get error message on loading a New Encounter referencing  
 

“Unknown database. 
Alias: ‘QTrace’ “ 

 
This generally means that the ODBC System DSN called QTSQLServer was not created 
automatically, [or only created for administrator - see foot of this section]. Add it manually 
by using the ODBC applet in Control Panel. The following information needs to be set up 
(page through the set up as necessary) 

Select the system DSN tab 
Use the Add button to create a new SQL Server data source 
Set the Name to “QTSQLServer” 
Set the description to “QuickTrace” 
Set the server name by selecting it from the drop down list. If not available, simply type 

in the server name. 
Check the check box to allow a different Default Database to be selected then select 
“QuickTrace” from the drop down list. 

Continue to page through until you can click the Finish button. Click the “Test Data Source” 
button to confirm all is well. This should report “Test completed successfully”. 

Note - we have seen one instance of the System DSN being created automatically but only 
being available when logged on to the network as administrator. The work round is to 



manually add a user DSN rather than a system DSN, while logged on to the network as the 
relevant user. Procedure is otherwise as for system DSN creation, described above. 

Report of client installation on ~W2000 Professional reporting “unknown alias qtrace” on 
trying to launch Encounter. Checked DSN was OK (NOT logged on as Administrator) after 
which it worked OK. May take a few seconds for the DSN to be recognised? 

 
7. If the LabelTrace Management Utility option does not appear on the Tools menu bar 

within GPASS, it may be because the GPASS installation is non standard. Locate the 
Newgpass.exe file which is being used on starting GPASS. Create (if not already there) a 
subfolder of the folder within which Newgpass.exe exists and name this new folder 
“External Tools”. Create a shortcut to “LabelTraceManagement.exe” (which is in the 
“LabelTrace” folder) in this “External Tools” folder and rename the shortcut “LabelTrace 
Management Utility”. On restarting GPASS, the menu option should now be available. As 
a last resort, place a shortcut on the All Users desktop! 

 
8. Printing via LabelTrace Print Manager is very slow 
 

If V 1.0.0.29 is installed this is almost certainly the problem, as it is permanently in debug 
mode so writes two lines of data to debug.txt every second!! Install latest version which 
may be downloaded from support section of our web site   www.quicktrace.co.uk 

9. Get message on trying to install “You must have GPASS installed to install this product…” 
 

This either means that GPASS is not installed at all or has been incorrectly installed 
(though it may run). The LabelTrace installer looks for the Registry key 

HKLM\\SOFTWARE\\Classes\\NewGpass.Application\\Clsid 
 
This (and a whole load of other NewGpass.* entries) are normally created when the gpass 
exe is installed. BUT - not only does GPASS have to be installed, but one valid login attempt 
must be made, as that's when it writes the Registry fields Label Trace needs! 
 
10. After selecting options for preferences, they fail to be displayed in the print window. 

Need to deinstall then reinstall the client software 
 
11. Preferences seem not to “stick” ie you set them up and then later they have changed. This 

can be due to an incorrect installation procedure leading to the preferences for several 
users being on the server instead of the local workstation. The preferences are 
consequently common to several users. In this situation, if user sets them on PC “A”, 
another user later sets different preferences on PC “B”, user on PC “A” will now have 
same preferences as set on PC “B”. Need to deinstall then reinstall ALL clients. 

 
12. “Unable to find label format” error on opening an encounter. This is sometimes found 

after a GPASS upgrade for reasons which are unknown. Reselect the path to the main 
templates folder via the Preferences option (you need to have administrative privileges 
for NT/2000/WP). This may also be related to a “Sharing violation” error on the server 
for unknown reasons. On the server, unshare then reshare the “Ltdata” folder. 

 
 
 



Software Issues SQLite Version 
 
1. During install of Management Utility or Client, may get messages re locked files, asking 

if want to overwrite - say Yes. 
 
2. If get message on launching LabelTrace that date settings are not correct, this is because 

the Regional settings need to be changed to English (United Kingdom) and the Short date 
format to dd/MM/yyyy.  NB If the settings appear correct but LabelTrace refuses to 
launch, this is due to internal corruption of settings in Windows. Set the date format to an 
alternative format then set it back to the correct format. 

 
3. After selecting options for preferences, they fail to be displayed in the print window. 

Need to deinstall then reinstall the client software 
 
4. Preferences seem not to “stick” ie you set them up and then later they have changed. This 

can be due to an incorrect installation procedure leading to the preferences for several 
users being on the server instead of the local workstation. The preferences are 
consequently common to several users. In this situation, if user sets them on PC “A”, 
another user later sets different preferences on PC “B”, user on PC “A” will now have 
same preferences as set on PC “B”. Need to deinstall then reinstall ALL clients. Before 
doing so make sure the Ltrace.ini file on the server is set to be read-only. Make it 
writable again after completing all re-installations. 

 
5.  “Unable to find label format” error on opening LabelTrace. This is sometimes found after 

a PC/server upgrade for reasons which are unknown. Reselect the path to the main 
templates folder via the Preferences option (you need to have administrative privileges 
for NT/2000/WP). This may also be related to a “Sharing violation” error on the server 
for unknown reasons. On the server, unshare then reshare the “Ltdata” folder. 

 
6.  Error message  “Unable to restore licence file. Error : the process cannot access the file 

because it is being used by another process” . This is due to a file locking issue on the 
server. Rebooting the server clears the problem. Microsoft Knowledge base article 

 
     http://support.microsoft.com/kb/129202/EN-US/ 

 
     references this issue. 
 
7. On EMIS LV/PCS sites running earlier versions of the script, may get error message on 

launching LT "Unable to parse date - expected DDMMYYYY format". This may be due to 
the EMIS user password changing but not being changed in the EMIS extension. It will 
also occur if no patient is selected or the Short date format is not set to dd/MM/yyyy.  
NB If the settings appear correct but LabelTrace refuses to launch, this is due to internal 
corruption of settings in Windows. Set the date format to an alternative format then set it 
back to the correct format. 

 
8.  On trying to configure the extension for EMIS with PCS get error “EMIS does not appear 

to be installed” – may be due to the EM_PACC.DLL file not being correctly registered. Try 
running “Regsvr32.exe “C:\Program Files\EMIS PCS\Modules\em_pacc.dll” “. 

 
9.  On  a Premiere site, if on launching LabelTrace get the error message 



     “…..your username and password are not defined. Ask your administrator to set up an 
Interbase login”, the password set in the Premiere extension has most likely expired in 
Premiere and may have been changed in Premiere but not updated in the extension. 

 
10.  Error message on launching LabelTrace. “An unhandled exception occurred 

[Microsoft][ODBC Driver Manager] Data source name not found or no default driver 
specified. LabelTrace will now terminate”. 

 
This can result from not having correctly configured the extension for Premiere or the ODBC 
connection properties on an individual workstation may be incorrect. It has also been 
reported when for an unknown reason an entry has disappeared from the central 
LTRACE.INI file. Check that the entry SQLitedb=labeltrace.db exists and if not add it in the 
[LabelTrace] section of the ini file. 
 
11.  On EMIS LV sites a user may report that LV is “frozen” after printing labels. This may 

simply be due to the user not having clicked in the LV window to return the focus to the 
LV application, causing the menu keystrokes to be passed to another application. 

 
12.  On EMIS LV sites may get error message “Unable to retrieve current patient from EMIS, 

no active patient or LV not logged on”. This may be because the user has not logged on 
to EMIS, or there is no patient selected. If both of these are OK then try restarting the 
PC.  

 
13.  On both LV and PCS sites, the error message “Unable to retrieve patient from emis 

Error(0) please check that you've selected a patient” has been seen to be due to 
compatibility mode issues under Windows XP and Vista. To check this use Windows 
Explorer, browse to the LabelTrace Program folder (usually C:\labeltrace\”), right click 
on the file “labeltrace.exe” and select Properties. Ensure that the Compatibility mode 
checkbox is NOT checked. 

 
14.  On EMIS LV sites, If using LabelTrace in screenscraping mode (Patient data “from 

screen” in the extension) and the screenscraping consistently fails on a PC, check if 
another keyboard macro application like “Macro Express” or similar is running on that 
PC and has been configured to use one of the keyboard shortcuts used by LV to copy 
data to the clipboard (ALT V, Alt S). This will prevent sceenscraping from working 
correctly. Disable the option in the keyboard macro application. Note that the 
screenscraping option can only be used if LabelTrace is launched from the Favourites 
menu. It cannot be used with an icon in the QuickLaunch section of the Taskbar. 

 
15.  On EMIS LV sites, a problem is sometimes found after Apollo have installed their 

document Management system on PCs with LabelTrace installed. This is because the 
following occurs:- 

      We install a file EM_PACC.DLL , supplied to us by EMIS - it is an up to date version.  
      Apollo then install in a different location an older version  
      LabelTrace fails because it tries to use the older version which does not support 

features we need.  
      to resolve the issue, the version we install needs to be "registered" with Windows. This 

up to date version will also allow the Apollo system to function. Do this by running the 
command line  

      regsvr32 c:\labeltrace\em_pacc.dll  
      in the Start/run box on each affected PC. 
 



16.  The central Ltrace.ini file can become locked on the server for no obvious reason. This 
may be resolved by restarting the server.  Alternatively, it may be due to the McAfee 
On-Access virus scanner locking the file. In one case, we identified Mcshield.exe 
(McAfee Netshield) as the program locking ltrace.ini.  (In a command window type 
“handle -a ltrace.ini”. In our case this returned 2 events with mcshield.exe associated 
with ltrace.ini). To solve this issue we added an exclusion to the On-Access Scanner of 
McAfee - any ini file in the LTData folder. We then stopped and started the McAfee 
Netshield service for the change to take effect. 

 
17.  If an older version of a script file for emis (\ltdata\scripts\emis.tcl.enc) has been left 

but renamed  as  e.g. “old_emis.tcl.enc”, it can interfere with the setting of configuration 
information, e.g. changing the password and make it appear to “stick” at the original 
value. Older versions of scripts, if they need to be retained, should either be moved to 
another folder or renamed so the file name does NOT end “.tcl.enc”. For example 
“emis.tcl.enc.old” will not cause a problem. 

 
18.  EMIS GV sites have experienced situations where users have clicked the LabelTrace 

icon with GV closed and LabelTrace has launched with the details of the last patient 
looked at in GV prior to closing. This is to be expected. There is no API for GV so we 
query the DB for the "last patient selected" ID number and then use this to query the DB 
for the rest of the demographics. Hence it will always be possible to get the situation 
above as the "last patient selected" ID number is not cleared on closing GV. We are 
looking at suppressing LabelTrace if GV is not running. 

 
19.  EMIS GV sites have reported that LabelTrace can be launched with details from the 

same patient constantly appearing, even though the patient has been changed in GV. 
We cannot replicate this. On testing, we have however found that if more than one 
instance of GV is open, then the details returned in LabelTrace are for the patient most 
recently looked up, irrespective of the instance of GV in which this was done. Hence, 
we advise that users only open one instance of GV, if possible.  

 
20.  In some circumstances one or more fields can fail to print…. 
 
a.   A field printing at 90 degrees to normal will fail to print if the data exceeds the space 

available in the image area. (in normal orientation it wraps to the start of the line). The 
%firstNchar% data modifier may be used to truncate data at the maximum data length 
to fit the image area. 

 
b.   If a field contains the double quote character, it will fail to print as the character is 

interpreted as the end of data character. Either remove the double quote character or 
replace it with a single quote character. Alternatively, the “onprint.tcl” script may be 
used to automatically carry out the required substitution when LabelTrace is launched. 

 
c.    If a Windows driver is installed for the printer and the printer is connected to a COM 

port, handhshaking may still be set to None (the default on installation). Set it to 
Hardware or Xon/Xoff. 

 
21.  On pasting in license data for a GPASS practice, LabelTrace appears to be licensed 

correctly. On relaunching from the Right Click menu, however, LabelTrace reports itself 
to be unlicensed. This is caused by having used licence data which does not include the 
“gpass_labeltrace” capability. Note – licenses omitting this required capability were 



originally issued to Scottish Health boards then immediately withdrawn. Ensure the 
correct license version is used. 

 
22. After moving or renaming the Management Utility Program file, the LTMU can fail to 

launch or can launch the wrong version. This is because a particular registry entry is 
being used to specify the program file location and it has been changed by Windows to 
a value which is now incorrect. To fix this edit the Registy key 
HKLM\Software\Microsoft\Windows\Current Version\App Paths\LabelTraceManagement.exe 

To have values 
Default: C:\LabelTrace\LabelTraceManagement.exe 
Path: C:\LabelTrace 
 
Later versions of the system use a different key so this does not occur. 
 

23.  On installing the Client or Management Utility  - if you are prompted thus 
      “Please enter the name of the machine running SQLServer” then cancel from the 

installation. This is caused by incorrect configuration of the central ltrace.ini file 
(normally in the “Ltdata” folder on the server). There should be an entry 
“SQLitedb=labeltrace.db” in the [LabelTrace] section of this file.  In a multi-practice set 
up this will be within the “Clean” subfolder of the “Ltdata” folder. Create this entry then 
run the installation. 
 

24.  On a Premiere site, can get message on launching LabelTrace, “No patient specified” 
even though one is selected if try to launch from the Add-ins menu while in data entry 
mode. 
 

25.  on trying to add a doctor get error message “Invalid attribute/option identifier” – can 
be caused by primary keys being lost during an SQL upgrade. Contact QuickTrace Ltd 
for guidance on rectifying this. 
 

26.  EMIS error message "unable to retrieve patient details from EMIS. Error: The following 
error occurred while dispatching the SOAP message. Socket error # 10061  Connection 
refused". This may be caused by a mismatch of the em_pacc.dll and the LabelTrace 
EMIS script. As of 6/6/08, there is a temporary patch at 
http://www.quicktrace.co.uk/temp/ltpatch_emis_1_25.exe which should resolve this. Contact 
our office for clarification though. Otherwise it is thought that this is an EMIS server 
error. Try restarting server and/or report to EMIS. 
 

27.  EMIS LV error message similar to "<LINER> SORTREG +49^EOPEN3A 3;4;2;" and 
replicated when use test harness. EMIS advise... "When random errors with <LINER> 
quoted are found in the API tester, recommend that the engineers check that the system 
is clinically patched up to date before trying again - this is done via EU PA C from the 
main menu, when it has finished it takes you back to the previous screen". 



 
28.  Error message on EMIS (normally PCS) sites saying...  
 

"An error occurred in GetObject : the specified module could not be found  
while executing "GetObject EM_PACC.PatientAccess""  

 

indicates that the em_pacc.dll file which should be in 
C:\Program files\emis pcs\modules 
is either missing or not registered with Windows. If necc download this file from the Support 

page of our web site and save it in the correct folder then run REGSVR32.EXE on it. The 
required command line to do so is confirmed on our web site. 

 
29.  On installing the LabelTrace client, the client window can display as being too big for 

the frame with larger than normal fonts. Go into Display Properties on Control Panel 
and ensure that, under the Appearance tab, Font size is set to Normal. Also go into 
Settings tab, then click Advanced button: DPI setting should be 'Normal size (96 DPI) - if 
not, make it so. If this does not solve the problem, locate and install an updated driver 
for the display. 
 

30.  If need to use a workstation as our "LabelTrace server", may need to modify some 
security settings of the LTDATA and LTINSTL folders to ensure everyone can read and 
write correctly to these folders at all times. 

 
      1. In Explorer, use "Tools/Folder Options/View" to untick "Use Simple File sharing", 

if necessary. 
      2. For the LTDATA and LTINSTL folders, ensure that the EVERYONE, USERS, GUEST 

and ADMIN USERS  groups are set to "Full Control" (you may need to add the 
EVERYONE group and GUEST, if not already existing).  

 
       If an XP workstation is used as the server, then some users may not be able to 

access the LTDATA folder as they are actually trying to access it as a Guest 
account and this is not permitted by the current configuration. In a workgroup 
situation Windows will try and connect with the local users username and 
password. If this fails it will try the guest account (if guest access is enabled). 
Failing that you get the 'supply your credentials' dialog.  

 
       If you want everybody (guest) to be able to access the share you first need enable 

the guest account:  
 
      Control Panel -> Users Accounts -> Guest -> Enable the guest account  
 
      Next ensure that the guest user has permission to access the shares. Check the file 

and share permissions.  
 
      If the user still can't connect you have to alter the Group Policy.  
 
      Start->Run->gpedit.msc  
 
      Then goto Local Computer Policy->Computer Configuration->Windows Settings-

>Security Settings->Local Policies->User Rights Assignment->Deny Access To This 
Computer From The Network and check that the Guest account isn't there.  

 



      If this still does not resolve the issue, check if there is an explicit user on the 
workstation with the same name as the user who cannot access the Ltdata folder. If 
so, ensure the explicit password set is the same as the user enters, or 
remove/rename this explicit user to avoid a conflict. 

 
31.  If LabelTrace appears to print a template (i.e. see yellow box) but there is no label 

printed and printing to file gives a blank output file though one is created, it may be a 
corrupt template (as has been seen on a VES site). It may also be because an EPL 
template has been selected when Brother type was required, or vice versa. 
 

32.  "unable to parse date” error can be seen on a single PC while others work. Don't know 
why but may simply start working again - so maybe server issue? Still under 
investigation. 
 

33.  Installing LabelTrace on the VES to print to a redirected printer, e.g. to get data to 
Brother printers via FlexaTrace to drive them requires the redirected printer to be 
forwarded into the TS session. This may not happen on some workstations. Solution is 
to add a registry entry to force redirection of the printer. This can be downloaded from 
the Support page, then run from the desktop. Note it is particular to the current 
Windows user. 
 

34.  LabelTrace on VES can give message the printer name “LTLabels” is invalid (or similar) 
if the user is simultaneously logged in to 2 sessions on different workstations. We 
understand that this may happen even though normally the first session will be logged 
out automatically, on logging in to the second session. 
 

35.  Setting up LabelTrace with PCS can get problem saving extension details or launching 
LabelTrace (with unknown error), if EM_PACC.DLL is 2007.5.10.1443. This is due to a 
problem with the “initialise with supplier ID” function. Patch using… 
 
      http://www.quicktrace.co.uk/temp/ltpatch_emis_1_33.exe  
 
      This version falls back to using “Initialise” if “initialise with supplier ID” fails. 
 

36   EMIS error message "unable to retrieve patient details from EMIS. Error: The following 
error occurred while dispatching the SOAP message. Socket error # 10060  Unknown 
Error".. This can be caused by the server IP address set in Configure Extensions being 
wrong. This can occur after EMIS have upgraded a site and changed the IP. 
 

37.  EMIS error message "Unable to connect to EMIS due to unknown error. Function now 
disabled please use Initialise with ID". The connection method to EMIS has changed 
and the LabelTrace installation has not been patched. Patch the site by following the 
instructions on the relevant patch page… 
 
      For PCS   www.quicktrace.co.uk/support/PCS/patch  (note is case-sensitive) 
 
      For LV    www.quicktrace.co.uk/support/LV/patch   (note is case-sensitive) 
 

38.  On trying to install LabelTrace get error message from Installshield 
      “Internal failure: Error Number 0x80040707, Description:   “ possibly with or without a 

description. This may be due to missing registry entries for default folders. See … 
      http://www.quicktrace.co.uk/tech/installshield_issues/0x80040707/0x80040707.htm 



39.  Launching Dart_OCM from LabelTrace – a problem has been seen whereby the e-Trust 
anti-virus system caused this to fail. The symptom is that the QTIexplore window 
appears briefly then disappears. Putting the C:\LabelTrace folder into the exclusion list 
for the anti-virus system resolved this issue. 

 
40.  B-Pac Client Component issue - "the feature you are trying to use is on a network 

resource that is unavailable" may be seen on trying to print via Brother printer. To work 
round this, copy the B-Pac installer from the \LTDATA\support\printers\brother\ 
folder on the server to a local drive and reinstall B-Pac support from there. 

 
41.  Get message on launching LabelTrace “Unable to locate Global Directory – 

LabelTrace will now close. This means that LabelTrace was unable to access the 
LTDATA folder in the specified location. Try browsing to the folder in Explorer. If 
necessary make sure that the sharing and permissions on the specified folder are 
correct to allow all users to have “full control” of the folders. Explicitly set these 
permissions for all relevant groups. Setting these for “Everyone” is not always sufficient. 
You should set permissions for “Users”, “Domain Users” etc. 

 
In some cases, simply browsing to the folder via Explorer will then allow LabelTrace to 
also read the folder. If necessary, create a shortcut to the LTDATA folder and place it in 
the “C:\Documents and Settings\All Users\Start Menu\Programs\Startup” folder. This  
workround will save user frustration. 
 

42. EMIS API may appear to be broken if the site has not had LV or PCS patched recently. 
Site have been found to be as much as 18 months out of date so the API components 
are incompatible with up to date em_pacc.dll. 

 
43 Problem of  default doctor not being displayed as expected on some PCs – check in the 

Management utility whether any doctor entries have  "username" set. If they have AND 
the “username” is passed in to LabelTrace along with the demographics and matches 
then the relevant doctor name will be displayed. This overrides any locally specified 
default doctor. 

 
44 "Unable to get Patient details - make sure you have selected a patient". This error can 

occur if there is another instance of EMIS.EXE (PCS) or LV.EXE (LV) running in memory, 
even though not visible. Close all open EMIS programs, then use Task Manager to 
check for, and if necessary terminate, any further EMIS.EXE or LV.EXE processes. Log 
back on and all should now work. 

 
45 Problem printing from  LabelTrace from within Terminal Services using the “Print from 

LabelTrace” option . The "Print From LabelTrace" printer appears in the TS session OK 
but LabelTrace hangs when trying to print to it and the client PC reports an error 
"Invalid data passed to PipeMessage". This can result from the locally installed printer 
being set to use a Redirected Port. Select the correct port for the physical printer. 

 
46 LabelTrace may fail to launch from Vision with error message “Unable to launch 

application. Reason ( )”. This can be due to there being “no open consultation” or the 
currently logged on Vision user having insufficient permissions set in Vision. 

 
47. EMIS PCS – error on trying to launch LabelTrace “EMIS API failed when Calling clinical 

System , Method InitializewithID. Error = Input string was not in a correct format.” Seen 
after Docman upgrade. Running QTEMISCHECK showed errors (incorrect path set to 



em_pacc.dll). resolved by manually registering the correct path to the Docman installed 
copy of the DLL (generally P:\PCTI\Docman\programs\em_pacc.dll). Equally, could 
register correct DLL from QT web site, installed in Labeltrace folder. 

 
48. Get error on launching LabelTrace “This application requires windows 2000 or higher.”  

This is caused by the shortcut for LabelTrace being incorrectly configured. Untick the 
check box for “run this program in compatibility mode for..”, on the Compatibility tab of 
the shortcut properties. 

 
49. On EMIS site got “socket error #10013 Access denied” on trying to launch LabelTrace. 

Test harness showed same error on running "InitialisewithID" - need to report to EMIS 
as a configuration error on the server. 

 
50. when Vision running on a TS environment The user logs into vision ok, clicks on the 

label trace icon and the pop up message reads "not known in global directory". This is 
a misconfiguration issue which INPS need to resolve. 

 
51. On Ganymede site- Get error message on trying to Launch "Cannot open database 

requested in Login "-patientid". Login fails." This is due to the command line which 
Ganymede generates to launch LabelTrace omitting the Database name. ISOFT need to 
resolve this. 

 
52. "user contract has expired" can be seen if the user set in the EMIS appt configure 

extension is made inactive in EMIS. 
 

53. On Premiere site get error message “{Dynamic SQL Error  SQL error code = -901  
feature is not supported}”. Check that the parameters are correctly set in the Configure 
Extensions option. For example in a previous incident, during the migration to Firebird,  
the "dbname" entry had been edited to "\\servername:c:\wincare\pcs.fdb" whereas it 
should have been “c:\wincare\pcs.fdb". 

 
54. On Premiere site get error message "An error occurred while running the script 

"\\servername\ltdata\scripts\premiere.tcl.enc" : IM02 {[Microsoft][ODBC Driver 
Manager] Data source name not found and no default driver specified} while executing 
"database connect db [getConnStr]". This can occur if the Premiere ODBC connection is 
missing or corrupt or incorrectly configured. Check by going to Start > Control Panel > 
Administrative Tools > Data Sources ODBC . > system DSN tab . select Premiere and 
test. If this fails, report it to ISOFT. 

 
55. On PCS site had issue on a single PC of inability to correctly register the em_pacc.dll, 

despite all attempts. QTEmisChecker reported for V2 of API. 
“Attempting to create EM_PACC.PatientAccess Object 
ERROR: An error occurred while trying to create the object : OLE error 80110802” 
V3 of the API was OK. 
EMIS investigated and reported… 
“I have received confirmation from out technical support team that the incident at the 
…….. Surgery should now be resolved. 
We have found a COM+ called EmisEmPacc which is tied to an EM_PACC.dll on the 
client. Re-registering of the API appears to disrupt this COM object in some way and 
renders the 2.1b interface inaccessible. We were able to rebuild the COM object and 
have tested both API interfaces successfully since.  



Tech Support has advised that we have seen this on a handful of other practices this 
week and the concern is obviously that if the API is re-registered again we will get the 
same problem. We need to establish where this new(?) COM has come from and raise 
this issue with the party responsible – we do not think it is EMIS software. 
In the meantime, should you encounter this problem again please report to our support 
desk quoting our knowledge base reference KB27672. 
 

56   When printing from LabelTrace via FlexaTrace on a local workstation configured to use 
the “Print from LabelTrace” function, can get a FlexaTrace error message "Invalid data 
passed to PipeMessage”. This results from the “Use FlexaTrace” checkbox in the 
LabelTrace Preferences being unchecked. 


